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Accessible publishing webinars

« Introduction to accessibility

- Checking accessibility of PDF files

- Creating accessible publications with Word

« Using Eurolook templates to create accessible publications
« Creating accessible PDF from InDesign

« Creating accessible presentations with Power Point

- Writing effective alternative texts

» Accessibility do’s and don’ts in social media

Check all our webinars in EU Learn



https://eulearn.europa.eu/ilp/pages/catalogsearch.jsf?catalogId=0&sidebarExpanded=true&q=%7B!q.op%3DAND%7D%20accessibility%20domain%20leader&rows=5

Contents

« Checking the accessibility of a PDF file
« Checking the colour contrast

« Screen readers

- NVDA






Tools to check a PDF

Adobe Acrobat Pro (Windows and macQS)

Metadata
Alternative texts
Tags panel

Order panel
Accessibility checker

pfGoHTML 2 Plug-in Callas pdfGOHTML 2 (Windows and macOS)

« Screen reader preview with tags
« Can check tags reading order and alt text

p/\c -------- PDF Accessibility Checker (PAC 2024) (Windows)
\

« PDF/UA and WGAG standards compliance
« Screen reader preview with tags (similar to Callas pdfGoOHTML 2)



https://acrobat.adobe.com/lu/en/acrobat/acrobat-pro.html
https://www.callassoftware.com/en/products/pdfgohtml
https://pdfua.foundation/en/pdf-accessibility-checker-pac

Characteristics of accessible PDFs

- Basic requirements
- Metadata

« Navigation

« Text

« Figures

« Structure

- Reading order

* Colour contrast



Basic requirements

« Document is tagged.

* No encryption / No password protection.
— Except if specially configured for reader devices.

 Initial view: Bookmarks panel and page.

- Magnification: Fit page.

« Document title displayed in the PDF title bar.
« PDF compliant with PDF/UA standard.



Metadata

Title

Author
— Usually the name of institution, agency or DG.

Primary language of the publication
— A PDF document can only have one primary language.

Subject and keywords



Properties: Description tab

Document Properties

ecurity Fonts  Initial View Custorn  Advanced

Uescrniption

Metadata | The OLAF report 2019
. Title Buthor: [OLAF
« Author

Subject: |Twer|tieth report of the European Anti-Fraud Office, 1 January to 31 December 2015,

Keywords:

« Subject

® Keyw 0 rd S Created: 08/09/2020 21:27:48

Modified: 08/08/2020 21:34:37

Additional Metadata...

Application:  Adobe InDesign 15.1 (Macintosh)

Advanced
PDF Producer: Adobe PDF Library 15.0
PDF Verzion: 1.7 (Acrobat 8.)
Location:  DAACCESSIBILITYY MEWM Accessibility trainings and demoesi\do\check PDP\demao filesh\Structure’,

Basic reqUirementS File Size: 4,85 MB (5 084 665 Bytes)

Page Size:  210% 297 mm Murnber of Pages: B0

® Tagged PDF Fast Web View: Mo

Help QK Cancel




Properties: Security tab

Basic requirements
 No encryption

* No password protection

Document Properties

Descriptio onts  Initial View Custom  Advanced

Document Security

The document's Security Method restricts what can be done to the document. To remove
security restrictions, set the Security Method to Mo Security.

Security Method: | Mo Security

Can be Opened by:  All versions of Acrobat

Docurnent Restrictions Surnmary
Printing:  Allowed
Changing the Document:  Allowed
Document Assembly:  Allowed
Content Copying:  Allowed
Content Copying for Accessibility:  Allowed
Page Extraction: Allowed
Commenting: Allowed
Filling of form fields:  Allowed
Signing:  Allowed

Creation of Template Pages:  Allowed

Help

Change Settings...

Show Details...

oK

Cancel




Properties: Initial View tab

Basic requirements

« Navigation tab:
Bookmarks panel and page

- Magnificaton: Fit page

« Show: Document title

Document Properties

Description  Security Fonts ustom  Advanced

Layout and Magnification

Mavigation tab: | Bookmarks Panel and Page ~
Page layout: | Single Page ~
Magnification: ‘Fit Page V|
Open to page: Ili of IV (60)
Window Options

[[] Resize window to initial page
[] center window on screen

O Open in Eull Screen mode

Show: | Document Title

User Interface Options
[JHide menu bar
[JHide teol bars

[JHide window contrals

Help

oK

Cancel




Properties: Advanced tab

Basic requirement

« PDF/UA compliance.

Metadata

* Primary language of
the publication

Document Properties

Description Security Fonts  Initial View Custo

PDF Settings

Basze URL: |

Search Index: |

Trapped: | Mo ~

PDF/UA Compliance: | PDF/UAWT - 150 142389-1 2014 ~

Print Dialog Presets

Page Scaling: | Default ~

DuplexMode: | Simplex ~

Paper Source by Page Sizet [ ]

Print Page Range: |

Mumber of Copies: | Default  ~

Reading Options

Binding: | Left Edge o

Language: ‘en-GB V|

Protected Mode: On

Help

Browsze...

oK

Clear

Cancel




Navigation

Table of contents

— Represents the structure of the publication and have links to the content.

Bookmarks

— Represent the structure of the publication and have links to the content.

Internal crosslinks

- Index, list of tables, list of figures...

External hyperlinks
— Applied to a meaningful text describing the link.
— Not just to the web address.

— Not “link to”, “click here” or "more information”.



« Text # image
— Selectable and can be copied as text in a text editor.

— No text converted to image, except:
o Part of a decorative element.
o Part of a graph with an alternative text.

* Font size
—Font size is readable. ,
o _ Body text: Arial 12 pt.
—Recommended minimum size 7| ¢ otnotes: Arial 9 ot.

« Other recommendations
— Sans-serif fonts.
— Avoid cursive and fantasy fonts.
— Limit the number of fonts to a maximum of 2 or 3.



- Meaningful images and charts

— Need an alternative text.

- Artifacts

— Decorative images excluded from the reading order.



Checking alternative text for images

'1 Simulation of alternative text - Adobe Acrobat Pro 2017

File Edit View Plug-Ins Window Help

Home Tools Simulation of altern... x

BEEeEQ @O /1 KR MO s - g BEAT © &

eQ—) ><

@ Order X
a Autotag Document
N @ C{ Autotag Form Fields
v @ Example 2 - Alt text.pdf Set Alternate Text ] ]
Reading Options
v Page 1
EI < Image 1 0f 2
2} & [1] Image @ Full Check
Alternate text:
Ny (2] Image @ Accessibility Report

(1Y
Lo

QURELY DECORATIVE -
' 'y

*t\ Setup Assistant

Reading Order




Checking alternative text for images (2)

'1 Simulation of alternative text - Adobe Acrobat Pro 2017 - O
File Edit View Plug-Ins Window Help

Home Tools Simulation of altern... x

BeEXRQ OO /1 M MO® % - BET O L

@ Accessibility ¥

@ Order X
N =0

v @ Example 2 - Alt text.pdf

Draw a rectangle around the content then click one of
~ @ Page 1 the buttons below:

I} Autotag Document

CQ Autotag Form Fields

Reading Order

Reading Options

2 [1] Image Text/Paragraph Figure @ Full Check
» =
‘Q Form Field Figure/Caption
4 [2] Image e
an H (21 9 Heading 1 Heading 4 Table @ ACCGSSIbIht}‘ Report
Heading 2 Heading 5 Cell
Heading 3 Heading 6 Formula E;" Identlfy Form Fields
+ Show reading order panel
Reference (q) Note (2) Background/Artifact
Show page content groups 4 E Set Alternate Text
N DECORATIVE 1 Table Edift
‘.’\'J?\EuD 'LE’“’!"{G;: v Display like elements in a single box i 4 -
*]y Setup Assistant
v Show table cells Show page content groups L \ P
v Show tables and figures © Page content order .
O Structure types Readlng Order
Edit Alternate Text... Show table cells @
Display like elements in a single block
Clear page structure Show tables and figures L

Alternate Text
‘ Clear Page Structure... ‘ ‘ Show Order Panel ‘

Alternate Text

- - ‘ Help ‘ ‘ Close ‘
Trave my it W and T sy ight clic
for accessibility!

[ o< ]| pontadanntex |




Tagging an image as an artifact Option 2

. Reading Order n | @ Accessibility -
Option 1 © 1] o

Draw a rectangle around the content then click one of -m:
the buttons below:
File Edit View Plug-Ins Window Help

Home Tools Simulation of altern... X | Text/Paragraph | -

B =4 Q 171 * @ @ @ 489% ﬁ E ? | Form Field || Figure/Caption

| Headingl | Headingd | Table

I} Autotag Document

@ Order X
N E-O®
] @ o [ e e B BT R 9 | Heading 3 ‘ | Heading 6 Formula
v [ Peee @ Full Check
| Reference (q) ‘ | Maote (z) | Background/Artifact
g T e .

) @ Accessibility Report

| Heading2 | Heading’5 | | Cell

Reading Options

&

& [21 M Show reading order panel

al :
L0 oie e G, Identify Form Fields
Show page content groups L
. . - P ==
v Display like elements in a single box =
play | g9 T n Set Alternate Text
v Show table cells ® .
Page content order 3 i
+ Show tables and figures ? N\, Setup Assistant
() Structure types
Cut Reading Order
Show table cells [

Delete Selected ltem Structure
Display like elements in a single block
Clear page structure

[] Show tables and figures [

Tag as text/paragraph
g Tag as background/artifact | Clear Page Structure... | ‘ Show Order Panel |

Tag as figure
| Help | ‘ Close |




Structure

« Headings
— Tagged as headings.
— They are properly nested.

 Lists
— Tagged with list tags.
— The nesting of list items represent the list structure.

» Tables
— Tagged as tables.
- With a header row.
— Not used for the layout purposes.

Heading level 1

Heading level 2
Heading level 3

Heading level 1

Heading level 2
Heading level 3



Checking the structure with Callas pdfGoOHTML 2

"X Alice's Adventures in Wonderland - Adob

File Edit View Certified PDF PitStop Prg

Plug-Ins

Home Tools Alice's Adventures I... X
B8 XQ © /0Dl NDMO® wx - RET ©L BE®B
Bookmarks X

El' @ Do ﬁL Alice's Adventures in Wonderland

Alice's Adventures in Wonderland (commonly shortened to Alice in Wonderland) is an 1865 novel
written by English mathematician Charles Lutwidge Dodgson under the pseudonym Lewis Carroll.
It tells of a girl named Alice falling through a rabbit hole into a fantasy world.

Alice's Adventures in Wonderland

Alice's Adventures in Wonderland (commonly shortened to Alice in Wonderland) is an 1865 novel written by
English mathematician Charles Lutwidge Dodgson under the pseudonym Lewis Carroll. It tells of a girl named
Alice falling through a rabbit hole into a fantasy world.

Wonderland

Bt @ < More information at Website of Alice.
[d Publication timeline

(&
N
@ | . [ Alice's Adventures in
Z
AN

[ Lists of characters

v ﬂ Synopsis

[] Chapter One -
Down the Rabbit
Hole

[1 Chapter Two - The
Pool of Tears

[1 Chapter Three - The
Caucus Race and a
Long Tale

[1 Chapter Four - The
Rabbit Sends a Little
Bill

[1 Chapter Five -
Advice from a
Caterpillar

Publication timeline

The following list is a timeline of major publication events related to Alice's Adventures in 5 z
Wondenand-g ore Alice, the rabbit and the mad hatter at the tea party

- 1865: First UK edition (the second printing).

- 1865: First US edition (the first printing of above).

- 1869: Alice's Abenteuer im Wunderland is published in German translation by Antonie
Zimmermann.

- 1869: Aventures d'Alice au pays des merveilles is published in French translation by Henri
Bué.

Publication timeline

The following list is a timeline of major publication events related to Alice's Adventures in WWonderland:

S - 1865: First UK edition (the second printing).




Structure versus no structure: Acrobat Pro

Laventures In vwonaeriand - A e A

]

File Edit View Plug-Ins Window Help

Home

8 X Q

@ Bookmarks

Tools

©

N & ThB

@ v D Alice’s Adventures in

Woenderland

[l Publication timeline

[l Lists of characters

v D Synopsis

[1 Chapter One - Down
the Rabbit Hole

[1 Chapter Two — The Pool

of Tears
[d Chapter Three — The

Caucus Race and a Long

Tale
[d Chapter Four - The

Rabbit Sends a Little Bill

[d Chapter Five - Advice
from a Caterpillar

(]

o

Alice's Adventuresi.. %

2 M O® os% - @ O e

Alice's Adventures in Wonderland

Alice's Adventures in Wonderland [commaonly shortened to Alice in Wonderland) is an 1865 novel
written by English mathematician Charles Lutwidge Dodgson under the pseudonym Lewis Carroll.
It tells of a girl named alice falling through a rabbit hole into a fantasy world.

More information at Website of alice.

4

Publication timeline

The following list is a timeline of major publication 2vents related to Alicz's Adventuras in
wonderland:

- 1B65: First UK edition (the second printing].

- 1865 First US edition (the first printing of abowe).

- 1869 Alice's abentauer im Wunderland is published in German translation by antonie
Zimmermann.

- 1869 Aventuras d'Alice au pays des merveilles is published in Fremch translation by Henri
Bus.

1 Example 4 - No structure.pdf - Adobe Acrobat Pro 2017
File Edit View Plug-Ins Window Help

Home Tools

B8 X Q @ 13
@ Bookmarks X
H B2 @B

@ v D Alice's Adventures in
35 Wonderland

19Y

Example 4 - No str... x

[d Publication timeline

[d Lists of characters

v H Synopsis
[1 Chapter One — Down the
Rabbit Hole
[1 Chapter Two — The Pool |4
of Tears

[d Chapter Three — The
Caucus Race and a Long
Tale

[d Chapter Four - The
Rabbit Sends a Little Bill

[d Chapter Five — Advice
from a Caterpillar

=B A -

539% -

A OB

Alice's Adventures in Wonderland

alice's adventures in Wonderland [commonly shortened to alice in wonderland) is an 1865 novel
written by English mathematician Charles Lutwidge Dodgson under the pseudonym Lewis Carroll.
It tells of a girl named Alice falling through a rabbit hole into a fantasy world.

More information at Website of alice.

Publication timeline

The following list is a timeline of major publication events related to Alica's Adventures in
wonderland:

1BE5: First UK edition (the second printing).

1B65: First US edition (the first printing of above).

1B62: Alice's Abenteuer im Wunderland is published in German translation by Antonie
Zimmermanm.

1B69: Aventures d'Alice au pays des illes is p
Bué.

in French t ion by Henri



Structure versus no structure: Callas pdfGoOHTML 2

— O - — O X
@ Alice's Adventures in Wonderla X + @ Microsoft Word - alice demo fin: X -+

C © @ File| C/Users/jerezma/AppData/Local/Temp/1/com.callassoftware.pdfGoHTML/pdf2... ¥ e : C 0 @ File | C/Users/jerezma/AppData/Local/Temp/1/com.callassoftwa... ¥ e :

Browser Default Basic Easy Reader Low vision Low vision Dyslexia

inverted Browser Default Basic Easy Reader

Low vision

hide images hide ALT texts ~- Low;i:an Dyslexia hide images hide ALT texts

"

Alice's Adventures in Wonderland

Alice's Adventures in Wonderland (commonly shortened to Alice in
Wonderland) is an 1865 novel written by English mathematician Charles
Alice's Adventures in Wonderland (commonly shortened to Alice in Wonderland) is an 1865 Lutwidge Dodgson under the pseudonym Lewis Carroll. It tells of a girl
novel written by English mathematician Charles Lutwidge Dodgson under the pseudonym named Alice falling through a rabbit hole into a fantasy world.
Lewis Carroll. It tells of a girl named Alice falling through a rabbit hole into a fantasy world.

Alice's Adventures in Wonderland

More information at Website of Alice.

Puhlinatinn timalina



Reading order




Reading order (2)

@ Tags X

- Tags reading order

— The order of the tags in this panel N B0
corresponds with the logical reading @ & T R
sequence. =
7 v Iﬂ <Sect=
. <H1=
. Layer reading order (> > &
— The order of the elements in this panel > &7
represents the logical reading sequence. @ Orddor x
H B0
« Other reading orders 2,
v B Example 3 - Structure ok.pdf
— Top to bottom.
v [4 Page 1
~ Left to right. ER
‘% . [1] Alice's Adventures in Won

= 2] Alice's Adventures in Worn



Checking the reading order

Callas pdfGOHTML 2

"L Alice's Advengues B Wanderland - Adobe Acrobat Pro 2017 - O x
@ Alice's Adventures in Wonderlan: X +
File Edit Vie indow Help
Mermn  TeRlE el Al sl & C 0 @ File| C/Users/jerezma/AppData/Local/Temp/1/com.callassoftware.... ¥¢ e

" Low visio
Browser Default Basic Easy Reader Inverted Low vision inverted

o - I_j ; see
B E Q @ 1./3 k @ e @ 20.5% (B ﬂslexia hide images hide ALT texts
@ Order X ~ 3

e's Adventures in Wonderland

N =0 S N e o e v Alice's Adventures in
Wonderland

@ s [l a girl named alice falling through a rabbit hole into a fantasy world.
v @ Example 3 - Structure ok.pdf ion at Website of Alice.
Alice's Adventures in Wonderland (commonly shortened to Alice in Wonderland)
is an 1865 novel written by English mathematician Charles Lutwidge Dodgson

Order panel Z | - [t
Tags pa nel % g [1] Alice’s Adventures in Won

under the pseudonym Lewis Carroll. It tells of a girl named Alice falling through

a rabbit hole into a fantasy world.

E | [2] Alice's Adventures in Wom

o )

= | [4] Publication timeline

.

= | [5] The following list is a time < ]

More information at Website of Alice .

= | [6] - 1865: First UK edition (th

&g [7] Image ey
> D Page 2 A
‘ollowing list is a timeline of major publication events related to Alice's Adventures in
5 derland:
> D Page 3
8E5: First UK edition (the second printing]
@EES: First US edition (the first printing of above).
869: Alice's im is i in German ion by Antonie
ZImmermant.
- 1869: Aventures d'Alice au pays des illes is publi in French ion by Henri
Bug
< > Source: Wikipedia




Automatic accessibility checkers

Adobe Acrobat Pro Accessibility Checker
) Full Check

PAC - PDF Accessibility Checker (PAC 2024)

7 . _
|¥| Resultsin Detail

Both are needed!!



Accessibility Checker of Acrobat Pro

Accessibility Tools Panel > Full Check

L Alice's Adventures in Wonderland - Adobe Acrobat Pro 2017

File Edit View Plug-Ins Window Help

Home Tools Alice's Adventures i... x

EBeRQ OO 1 /s

® Accessibility ~

@ Accessibility Checker X

N =
Document (2 issues)
& Accessibility permission flag -
3 Image-only PDF - Passed
¢ Tagged PDF - Passed
ﬁ Logical Reading Order - Nee
4@ Primary language - Passed 4

o Title - Passed

4 Bookmarks - Passed

ﬁ Color contrast - Needs man

Detailed report

Page Content
Forms
Alternate Text

Tables

I} Autotag Document

Alice's Adventures in Wonderland

Aice's in to Alice in )iz =n 1865 novel
written by English mathematician Charles Lutwicge Dodgson under the pseudonym Lewis Carroll.
It tefks of & g named Alice falling through a rabbit hole into- s fantasy world.

@ Autotag Form Fields

Maore information at Website of Alic,

Reading Options

@ Full Check 9

® Accessibility Report

5}. Identify Form Fields
>

E Set Alternate Text

ety

*R, Setup Assistant

Publication timeline

The following list is 3 timeline of major i to Alice's
‘Wonderiand:

- 1865: First UK ecition (the second printing] E Readin g Order
- 1865: First US edition {the first printing of sbove). =

- 1369: Alice" B i ian by Antarie
Zimmermann.

- 1869: Aventures d'Alice au pays des merveilles is published in French translation by Henri
Bue.

Source: Wikipedia




PDF Accessibility Checker 2024

M\ PAC 2024 - POF Accessibility Checker — Y
\
[ﬁ Open document - x FDF/UA 83
w x Basic requirements 7
Title jalice’s Adventures in Wonderland » « IS0 32000-1 0
Filename Example 3 - Structure ok.pdf » « Fonts i}
language  EN-GB » x Content 77
Pages 3 > ( Embedded Files 0
Tags 79 » « Natural language 0
Size 349 KB + & Logical structure 5
» x Structure Elements 3
o
HroFuA | M woas | o Qualiy Q » {1y Structure Tree 1
» ( Role mapping 0 y
This PDF file is not PDF/UA compliant. » x Alternative Descriptions 1
w x Metadata and Settings 1
Checkpoint Pazszed Warned Failed
" PDF Syntax (150 32000-1) 33 0 0 » x Metadata 1
« Fonts 3 0 0 » ( Document settings 0
® Content 5144 0 77 » P wcae
" Embedded Files 1 0 0
" MNatural language 3058 0 0
*® structure Elements 15 0 3
A Stucture tree 73 1 0
+" FRole mapping 135 0 0
M Alternative Descriptions 158 0 1
M’ Metadata 2 0 1
' Document settings 4 0 0
@ Results in detail PDF report ?-EI i" @

Detailed report






Colour contrast

« Text contrast ratio 4.5 : 1 (WCAG AA)

— Contrast for regular text against the background.
« Text contrast ratio 3 : 1 (WCAG AA)

— Contrast for large text against the background.

— Large text is a text that is larger than 18 pt or larger than 14 pt if bold.
* Non-text contrast ratio 3 : 1 (WCAG AA)

— Contrast of graphical objects against adjacent colours.




Tools to check the colour contrast

----------------------- Colour Contrast Analyser (Windows and MacOS)
\/\/ebAIMQ ------------- WebAIM Contrast Checker (online)
Contrast Checker

4 ’ ....................... Adobe Color (online)

....................... GIMP (Windows and macOS)

® Colblindor - Coblis — Color Blindness Simulator (online)


https://www.paciellogroup.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/
https://color.adobe.com/create/color-contrast-analyzer
https://www.gimp.org/
https://www.color-blindness.com/coblis-color-blindness-simulator/

Colour Contrast Analyser

I Colour Contrast Analyser (CCA) - X
Colour Contrast Analyser (CCA) Edit View

Contrast ratio 3.3:1

Foreground colour

hsl(50,100%,60%)

1

Background colour

¥ Sample preview

example text showing contrast m

WCAG 2.1 results

> 1.4.3 Contrast (Minimum) (AA)

@ Pass for large text only @ Fail for regular text

» 1.4.6 Contrast (Enhanced) (AAA)

@ Fail for large and regular text

¥ 1.4.11 Non-text Contrast (AA)

The visual presentation of user interface
components (their states — including focus indication —
and boundaries) and graphical objects has a contrast ratio
of at least 3:1 against adjacent color(s)

@ Pass for Ul components and graphical objects




WebAIM Contrast Checker

157

WebAIM

web accessibility in mind

Q services articles  resources

[ 7] !

g [Searcl‘:

g [Introductior to Web Accessibilit}rl

9 WebAlM Training

Contrast Checker

Home > Resources > Contrast Checker

¥20399D

Alpha Color Picker

Foreground

Hex Value

Background

Hex Value

Sfeeere

Luminance

" I

Contrast Ratio

9.84:1

Normal Text

permalink

weac aa: (2D
(PN Pass )

Large Text

The five boxing wizards jump quickly.

weae A ()
weaa asa: (D)

The five boxing wizards jump quickly.

Graphical Objects and User Interface Components

weac as (D)

v

|Text|nput |

projects  community

@ Related Resources

Contrast and Color
Accessibility

Quick Reference: Testing
Web Content for
Accessibility

WebAIM Auditing &
Evaluation Services
Web Accessibility for
Designers

Link Contrast Checker
Contrast Checker
Bookmarklet




GNU Image Manipulation Program

Adobe COIOr a nd GI M P COIou r picker File Edit Select View Image Layer Colors Tools Filter:-.ll"."."i.nn:l:;s. Help

Contrast Checker v @ AA

Extract Theme Extract Gradient

WCAG 21 Level

;
vO

Text Color

Accessibility Tools

] Import Colors

#FFFFFF

Preview

Regular Text

Ahigh color
contrast makes

anything easier
to read

® Fail formpt and below

@' Pass forispt and above / 14pt bold and above

Background Color

Large Text

A high color

contrast makes

anything easier

to read

Recommendations ~ Save

Contrast Suggestions v

Apply Contrast Ratio 5.0:1
Contrast Ratio (2) .
T -
3.84:1 -
- - ) il
Apply Contrast Ratio 5.0:1 -
-

S T

Apply Contrast Ratio 6.0:1

LK B A I

Set a Contrast Ratio

Change Foreground Color

Cancel

@' Pass for icons and actionable graphics

Cancel




Color Blindness Simulator

Drag and drop or paste your file in the area below or: | Choose File | chart - colour jpg

Trichromatic view: Anomalous Trichromacy: Dichromatic view: Monochromatic view:

O MNormal O Red-Weak/Protanomaly O Red-Blind/Protanopia O Monochromacy/Achromatopsia
O Green-Weak/Deuteranomaly ® Green-Blind/Deuteranopia O Blue Cone Monochromacy
O Blue-Weak/Tritanomaly O Blue-Blind/Tritanopia

Use lens to compare with normal view: ®No Lens O Normal Lens O Inverse Lens
Reset View Open simulated image in new window

Chart Title

m 62% m 38%

® Label 1

m Label 2

‘IIIIIIIIIIIIIIIIIIIIIIIIIII’

Chart Title

- 62%

u 38%

= Label 1

m Label 2

Drag and drop or paste your file in the area below or: | Choose File | chart - colour jpg

Trichromatic view. Anomalous Trichromacy: Dichromatic view: Monochromatic view:

O Normal O Red-Weak/Protanomaly O Red-Blind/Protanopia ® nonochromacy/Achromatopsia
O Green-Weak/Deuteranomaly O Green-Blind/Deuteranopia O Blue Cone Monochromacy
O Blue-Weak/Tritanomaly O Blue-Blind/Tritanopia

Use lens to compare with normal view: ®No Lens O Normal Lens O Inverse Lens
Reset View Open simulated image in new window

Chart Title

m 62% m 38%

H Label 1

m Label 2




Color filters in Windows 10

Start > Settings > Ease of Access > Color filters

= Settings — O X

Settings - O X

r Home CO|OI’ ﬁ|teI’S

Windows Settings

Make photos and colors easier to see by applying a color filter to your
screen.

| Find a setting | Find a Sett'lng O

Ease of Access

g System Devices I:] Phone Use. color ﬁlters
Displ. nd, notifi 2l Bluetooth, printers, mouse Link your Android, iPhone
power
Turn on color filters
Network & Internet j Personalization E—  Apps Vision
@ ‘Wi-Fi, airplane mode, VPN I:-‘_] Background, lock screen, colors BB Uninstall, defaults, optional @:) Oﬁ
features

[J Display D Allow the shortcut key to toggle filter on or off
Gami

G;Te‘lgall_ captures,
broadcasting, Game Mode

R Accounts ('-\,_._, Time & Language
Your accounts, email, sync, Speech, region, date
work, other people

S

Press the Windows logo key & + Ctrl + C to toggle filter on or off.
My Cursor & painter size

Documents Ease of Access Privacy - Update & Security
~="" Narrator, magnifier, high & Location, camera R~ Windows Update, recovery @ Magnifier Select a color filter to see elements on the screen better
contrast backup

Pictures

(@) Inverted (reverse colors on the dis
Settings Search Color filters 4
Language, permissions, history

Power () Grayscale

% High contrast

@]

L2 g

) Grayscale inverted

i’ Narrator

Or select a colorblindness filter ta make the nine colors on the wheel
more distinct.

Shortcut for filters: Win + Ctrl + C




Color filters in Windows 11

Start > Settings > Accessibility > Color filters

All

=
1

T

Seguridad de Windows

Cuct

Settings
System

Skype for Business

Software Center

Sticky Motes {new)

Terminal

uniFLOW SmartClient
Mew

uniFLOW SmartClient
New

3

v
®

Home

System

Bluetooth & devices
Network & internet
Personalization
Apps

Accounts

Time & language

Gaming

Privacy & security

Windows Update

Accessibility

Vision

AA

Text size
Text size that appears throughout Windows and your apps

Color filters

Visual effects
Scroll bars, transparency, animations, notification timeout

Mouse pointer and touch
Mouse pointer colar, size

Text cursor
Appearance and thickness, text cursor indicator

Magnifier
Magnifier reading, zoom increment

Color filters

Colarblindness filters, grayscale, inverted

Contrast themes
Color themes for low vision, light sensitivity

Marrator
Voice, verbosity, keyboard, braille

Keyboard shortcut for color filters
1+ C to tumn color filters on or off

Accessibility > Color filters

Red
Orange
Yellow
Green
Blue

Purple

Press the Windows logo key & + Ctr

Shortcut for filters: Win + Ctrl + C







Free screen readers

NVDA (Windows)

Check our videos about how to test
different types of files with NVDA

Voice Over (macOS and iOS)
Already included in the operating system



https://www.nvaccess.org/download/
https://op.europa.eu/en/web/accessibility/how-to-guides#chapter-6
https://op.europa.eu/en/web/accessibility/how-to-guides#chapter-6

Preparing Acrobat Reader or Acrobat Pro

1. Check settings for Acrobat Reader
Edit > Accessibility > Setup Assistant...

Select:
« Infer reading order from document

« Read entire document at once

2. Check settings for Acrobat Pro
Edit > Preferences > General... > Reading
Select:
« Reading Order: Infer reading order from document
« Page vs. Document: Read entire document at once
Accessibility Tool > Reading options:
« Reading Order: Infer reading order from document

« Reading Mode Options: Read the entire document



Tips for using NVDA to check PDF files

1. Know how to exit NVDA
Click NVDA icon in the taskbar > Exit

2. Add Focus Highlight plugin
To install: right click NVDA icon in taskbar, Tools > Manage add-ons > Get add-ons
Click Focus Highlight > Download stable version.

3. Mute the sound when not needed
Insert + S

4. Instead of sound you can activate speech viewer
Right click NVDA icon in the taskbar > Tools > Speech viewer

5. Control the loudness of NVDA speech with Volume Mixer tool

Taskbar > Speakers > Open Volume Mixer > Adjust volume for NVDA
application when it runs

Preferences
Tools

Help

Configuration profiles...

Revert to saved configuration

Reset configuration to factory defaults

Save configuration

Donate

Install pending update

Volume

B System sounds
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Shortcut keys for NVDA

Modifier key (NV)
Insert key and/or CapsLock key

Note for MAC users

Possible to run NVDA if Windows10 is
installed as a parallel OS.

Modifier key: Num Pad key “0”.

Read from cursor till end
Laptop keyboard: NV + a
Desktop keyboard: NV + Down

Pause reading
Ctrl

Chose where to start read
Double click in the document

Read next/previous line
Down / Up

Go to next/previous heading
h / Shift h (Only works if document contains headings)

Open Elements List to see all Links and list of all
Headings

NV + F7 (Required setting: Read entire document at once)

Go to next/previous table
t / Shift t (Only works if document contains tables)

NVDA keyboard shortcuts



https://op.europa.eu/documents/d/accessibility/accessible-publishing-nvda-keyboard-shortcuts

Questions?

OP-ACCESSIBLE-PUBLICATIONS@publications.europa.eu

Accessibility site of the Publications Office



mailto:OP-ACCESSIBLE-PUBLICATIONS@publications.europa.eu
https://op.europa.eu/en/web/accessibility/accessibility
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